
SmartSoft-AES Software Release Notes 

 

___________________________________________________________________________ 

 

Release 4.7.0 – February 2018 

___________________________________________________________________________ 

 

OVERVIEW 

SmartSoft-AES V4.7.0 adds Windows 10 64-bit OS support (unofficial); adds EPIX frame 

grabber support. 

 

PLATFORM 

Windows XP; Windows 7 (32/64-bit OS); Windows 10 (64-bit OS) 

 

NEW FEATURES/BUG FIXES 

 

General UI 

1. Windows 10 Support:  SmartSoft-AES now includes WinUSB driver support (i.e. 64-bit 

support) for all USB devices.  This support should be included as the factory setting; but 

can also be configured by modifying the Setting\ConfigManager\Properties\Properties.phi 

file. 

2. Main Menu>Tool>System Configuration…>Hardware>Frame Grabber: The EPIX PICXI 

A110 Frame Grabber frame grabber support is included; and replaces the obsolete 

PC2Vision card. 

 

System 

3. System>Vacuum>Context Menu>Pressure Log: A simple vacuum pressure log is now 

available to record intro and chamber pressures.  The pressure values are written to the 

Settings/Vacuum/Logs/Vacuum Log.phi file at 1 hour intervals.  Note: the write interval 

can be modified in the Setting\Vacuum\Properties\Properties.phi file. 

 

 

FIXED FROM PREVIOUS VERSION 

 

1. Sample>Stage>Properties…>Center Of Rotation:  The center of rotation calculation was 

not correctly adjusting for the electronic image shift in the SEM menu, which resulted in 

poor accuracy when driving to position in the position list.Fixed. (SMART-Tool) 

2. Sample>Stage>Comp R: 'Compucentric Rotation' does not work if stage R is at 30.0 

degrees or over.  The correct limit is 30.0, and is now allowed. (921 Stage Control) 

3. Sample>Stage>User Settings: "INTRO" and "EXTRACT" User Settings are not included 

when configured with the 921 Stage Control. Fixed (921 Stage Control) 

4. SEM>SEM Image Jitter: This was caused by the stage motors remaining enabled following 

a move.  There is now an option to disable motors after stage move.  This option is located 

in the Setting\Stage\Properties\Properties.phi. (921 Stage Control) 

5. Hardware>Ion Gun:  Starting 'Timed Sputter w/Zalar' on ion gun hardware causes access 

violation error. Fixed. (921 Stage Control) 

 

KNOWN BUGS 

1. Some USB thumb drives can cause a loss of communication with the Bertan. 

 

HELPFUL HINTS 



1. Entry fields must be 'terminated' either by selecting the <Enter> key or by moving to 

another parameter field.  If the application is exited before the value is terminated the 

change will not be saved. 

            

NOTES 

1. SmartSoft-AES does NOT support the following options: 

a) SMART-II systems configured with a FOUP 

b) SMART-200 systems 

c) MicroBeam Ion Gun 

 

2. For more information on known issues please see the following document: C:\SMARTSoft-

AES\Bin\TroubleShooting.doc. 

 

___________________________________________________________________________ 

 

Release 4.6.0 – April 2017 

___________________________________________________________________________ 

 

OVERVIEW 

SmartSoft-AES V4.6.0 adds support for the model 921 PHI Stage Controller.  The 921 

Stage Controller is a functional replacement for the MEI Stage Controller (obsolete). 

 

This version is for AES-680/690/700 systems only and is not officially supported on Smart-

Tool instruments.  

 

PLATFORM 

Windows XP; Windows 7 (32-Bit) 

 

NEW FEATURES 

 

General UI 

1. Hardware Configuration: With the 15-680 stage selected there are three stage controller 

options: ISA|PCI|921.  Note: the 921 Stage Control only supports the Return To Home 

option following a Zalar rotation.     

 

___________________________________________________________________________ 

 

Release 4.5.0 – February 2017 

___________________________________________________________________________ 

 

OVERVIEW 

SmartSoft-AES V4.5.0 is a general release for all AES systems with pre-Tucson electronics 

(AES-680/690/700/SMART-Tool).  This version adds new features and bug fixes listed 

below. 

 

PLATFORM 

Windows XP; Windows 7 (32-Bit) 

 

NEW FEATURES 

 

General UI 

6. Menu Bar>System Log: System log files are now stored in the C:\SmartSoft-AES\Log 

directory 



7. Status Bar: The size of the status line fields can now be customized.  Field sizes can also 

be returned to the factory settings by selecting the Reset Default Size option from the 

status line context menu. 

8. Status Bar>Highlight: The highlighting tool indicates which menu items are Settings and 

which items are Properties.  Settings are loaded as a group of values using the 

Settings>Load command while Properties are common across the entire system. 

9. Menu Bar>Automation>AutoTool:  The Active list item adds the ability to deselect a task 

from the sequence without permanently deleting the task. 

10. MenuBar>Automation>AutoTool: The AutoTool Wait Chamber Pressure feature monitors 

the system pressure, pausing the AutoTool processing until a target system pressure is 

achieved. 

11. Menu Bar>System>E-Mail Notification: One can now send custom email messages or text 

messages during the running of an AutoTool sequence.  This is accomplished by using the 

AutoTool Send E-Mail task. 

12. Menu Bar>System>Coffee Timer: This feature adds the capability to schedule the 

processing of an AutoTool task at a specified day and time. 

 

System 

13. System>Intro Camera: External image files (.bmp, .jpg) can now be imported and used to 

navigate on the sample.   

 

Sample 

14. Sample>Z Align:  An updated Z position can now be sent to the position list following a 

successful Z-Align. 

15. Sample>Position List: All Z position can be updated by selecting the “Set All” option from 

the popup menu. 

16. Sample>Position List: The “Update Position” toolbar button now updates all position (UV 

and XYZRT). Other update options are available using selections in an associated popup 

menu. 

 

SEM 

17. SEM>SEM Image: A real-time SEM histogram equalization graph is now available. 

18. SEM>KnobBox: The knob box can now be customized to change the behavior of the 

pressed and un-pressed knob states.  Many users find it easier to use the pressed state for 

coarse moves and un-pressed state for fine moves.  (SmartSoft-

AES\Settings\Properties\Properties.phi) 

 

AES 

19. AES>Data Manager: The acquisition directory can now be either globally defined or saved 

with each sample. 

20. AES>Survey, Multiplex, Line>More: The number of more cycles can now be defined.  This 

capability has also been added to AutoTool. 

 

Hardware 

21. Hardware>Ion Gun: Systems configured with the 20-066 ion gun control supports an 

extended set of diagnostics readbacks.  Note: this may require a firmware upgrade. 

22. Hardware>Ion Gun: The emission current startup ramping is optimized to improve the 

lifetime of the ionizer. 

 

FIXED FROM PREVIOUS VERSION 

 

1. Sample>Position List: Driving to a position in the position list ignores the Z limits. - Fixed 



2. Sample>Stage: The stage initialize sequence does not properly report axis name when in 

motion. - Fixed 

3. Sample>Stage: Following a Zalar rotation the stage is always returning to the "Home" 

position; ignoring the "Return to Home" option. - Fixed 

4. Sample>Stage>Joystick: Driving Z-Up and Z-Down ignores the Z limits. - Fixed 

5. Sample>Z Align:  SmartSoft-AES locks-up when using the slew-up or slew-down arrow 

keys.  On some systems this software lockup results in a hard computer crash (i.e. blue 

screen).  The slew capabilities for the X, Y, Z and T axes have been replaced with step-up 

and step-down buttons.  Note: The mouse wheel can be used in place of the slew button 

for continuous moves.  Note: The R axis still supports the slew capability. 

6. SEM>SEM Image: A vertical noise streak is visible on the SEM image on systems 

configured with the scintillator option - Fixed 

7. Hardware>Ion Gun: The neutralizer setting cannot be change unless the gun is in the 

Neutralize mode. - Fixed 

8. Sample>Navigation: Stage does not correctly move to defect position after the defect 

position has been updated with Actual U, V positions. 

 

KNOWN BUGS 

2. Some USB thumb drives can cause a loss of communication with the Bertan. 

 

HELPFUL HINTS 

2. Entry fields must be 'terminated' either by selecting the <Enter> key or by moving to 

another parameter field.  If the application is exited before the value is terminated the 

change will not be saved. 

            

NOTES 

3. SmartSoft-AES does NOT support the following options: 

a) SMART-II systems configured with a FOUP 

b) SMART-200 systems 

c) MicroBeam Ion Gun 

 

4. For more information on known issues please see the following document: C:\SMARTSoft-

AES\Bin\TroubleShooting.doc. 

 

___________________________________________________________________________ 

 

Release 4.4.2 – April 2014 

___________________________________________________________________________ 

 

OVERVIEW 

SmartSoft-AES V4.4.2 includes critical bug fixes for V4.4.1 

 

FIXED FROM PREVIOUS VERSION 

 

1. Wafer transfer as a one step process does not work due to a Smartsoft timeout error 

before good vacuum is reached in the intro.    

a) Work Around: Transferring sample first to the intro then to the stage after waiting for 

good vacuum.  

b) Fix: Changes V1 timeout from 5 minutes to 60 minutes.  Timeout values can be 

modified by editing the text file: PlatenManagerSMART>Properties>Properties.phi. 

2. After the transfer is complete, the intro is still not pumped 

a) Fix: Sample Transfer>Properties>Sample To Stage>Skip Pump Intro|Pump Intro allows 

option to pump intro at the end of a transfer sequence to the stage. 



3. Sample location in system can be altered by user with drop down box with no error 

checking from Smartsoft or confirmation message.   Should be a service mode function 

only. 

a) Fix: Sample position is now "Service" password protected. 

4. AutoTool>FOV command generates an error exception when running the sequence: Fixed 

5. SEM>Focus:  Need 3 decimal points of precision for focus. - Fixed 

6. Brightness function in FIB menu does not work w/Scintillator 

a) Fix:  FIB menu now displays the "PMT 1 (V)" parameter when system is configured with 

scintillator. 

 

KNOWN BUGS 

1. Some USB thumb drives can cause a loss of communication with the Bertan. 

 

HELPFUL HINTS 

1. Entry fields must be 'terminated' either by selecting the <Enter> key or by moving to 

another parameter field.  If the application is exited before the value is terminated the 

change will not be saved. 

            

NOTES 

1. SmartSoft-AES does NOT support the following options: 

a) SMART-II systems configured with a FOUP 

b) SMART-200 systems 

c) MicroBeam Ion Gun 

 

2. For more information on known issues please see the following document: C:\SMARTSoft-

AES\Bin\TroubleShooting.doc. 

 

___________________________________________________________________________ 

 

Release 4.4.1 - Jan, 2014 

___________________________________________________________________________ 

 

OVERVIEW 

SmartSoft-AES V4.4.1 includes bug fixes which apply to all SmartSoft-AES based systems. 

 

NEW FEATURES 

 

General UI 

1. User Settings 

a) User settings combo boxes now store a history of the 5 most recently used user 

settings.  These recent settings are displayed at the top of the combo box list followed 

by a separator.  Also, reserved settings are now grouped at the bottom of the combo 

box list.  In previous versions the reserved settings were scattered throughout the list 

appearing in alphabetical order.   

 

FIXED FROM PREVIOUS VERSION 

1. Sample>Aligment>Z-Align: Running Z-Align generates an exception (error) when the 

configured with manual stage control (None or 15-630).  Selecting OK will close the error 

box and continue with a normal Z-Align. - Fixed 

2. SEM>SEM: Magnification value missing from .sem files.  Because of this MultiPak display 

the wrong magnification on the image. - Fixed 



3. AES>Survey: Acquisition area is at an incorrect position during acquisition.  This problem 

only occurs when an analysis area is followed by an analysis point. This problem was 

somewhat intermittent. - Fixed 

4. AES>Spectral Viewer: On v4.1.3 users can close files displayed on spectrum viewer or 

profile viewer during an acquisition. However, v4.4.0 does not support this feature. - Fixed 

5. Ion Gun>Sputter: the Auto Shutdown feature closes V8 but not v4. Should also close v4. - 

Fixed 

 

KNOWN BUGS 

1. Running "Intro Gate Vale-Open(V1)" task executes "Pump Intro" instead of the selected 

task - "Intro Gate Vale-Open(V1)”.  However, the intro gate valve (V1) functions correctly 

as part of all transfer sequence.  Use Watcher as a workaround to manually open and close 

V1. 

2. Also, manually opening and closing other valves (i.e. V2, V3, V4, and V8) in service mode 

fails.  Again, use Watcher as a workaround. 

 

HELPFUL HINTS 

1. Entry fields must be 'terminated' either by selecting the <Enter> key or by moving to 

another parameter field.  If the application is exited before the value is terminated the 

change will not be saved. 

2. System>Vacuum: A “Diff pump Ion gun On“ task failure is typically caused by an 

incompatible version of the Watcher macros.  This can be fixed by updating the Watcher 

macros.  Workaround: Use the “Diff pump Ion gun On“ task from inside the Watcher 

program.  

3. System>Stage>2 Inch Sample (60mm): Using "Defect File" style navigation limits stage 

motion based on the tilt angle (indicated by the red line on the sample viewer).  "Intro 

Photo" style navigation removes the stage limits, but requires additional care when moving 

the stage to avoid driving the sample into the nose cone of the analyzer. 

            

NOTES 

1. SmartSoft-AES now supports SMART-II systems with the Manual Intro upgrade.  However, 

it does not support previous configurations of the SMART-II systems with the Front 

End/FOUP 

2. Additional hardware NOT supported: SMART-200, MicroBeam Ion Gun 

 

3. For more information on known issues please see the following document: C:\SMARTSoft-

AES\Bin\TroubleShooting.doc. 

                              

___________________________________________________________________________ 

 

Release 4.4.0 - Oct, 2012 

___________________________________________________________________________ 

OVERVIEW 

SmartSoft-AES V4.4.0 adds manual wafer transfer support for SMART-II systems.  This 

version also includes numerous UI improvements and bug fixes which are available for all 

SmartSoft-AES based systems. 

 

NEW FEATURES 

 

General UI 

2. Manual Wafer Transfer (SMART-Tool) 



a) Adds Intro>System Birds-eye Glyph: Gun Status; Sample Status; Drag and Drop 

sample transfer; System Pressure; Valve Status; Manual Valve Control (Service Mode 

only) 

b) Adds Intro>Vacuum Application: Application Log, and Diagnostics Menu 

3. SmartSoft>File>Save System Parameters:  SmartSoft-AES parameters can be saved 

periodically to the system files.  The save interval options are 5, 10, 30, and 60 minutes.  

There is also the “Never Save“ option to disable the auto-save feature. 

4. SmartSoft>File>Save System Parameters: Prompting the operator when application 

settings have changed can be disabled by selecting the “Don’t Prompt” menu item.  This 

allows the operator the ability to choose when updates are to be saved, without being 

continually prompted. 

5. SmartSoft>Menu Bar>Tools>Configuration: Added support for either Argon “Fixed Leak“ 

valve or “Thermo Leak“ valve. 

 

System 

6. System>Transfer:  Add support for one-button sample transfers on systems configured 

without Watcher (i.e. systems that are configured with the AVC:auto valve control) 

 

Sample 

7. Sample>Sample Viewer>Toolbar>Grab Cursor: Interactively pans the Sample Viewer 

image by holding down the <left mouse> and moving the mouse cursor. 

8. Sample>Stage: Add support for PCI version of MEI board (15-680 stage only). 

9. Sample>Position List>Create Position…>Point Generation: Support is now available to 

create multiple positions using a number of different fill patterns (e.g. circle, cylinder, 

square).  The default fill pattern creates evenly spaced points across the current FOV.     

 

SEM 

10. SEM>SEM Viewer>Toolbar>Grab Cursor: Interactively pans the SEM Viewer image by 

holding down the <left mouse> and moving the mouse cursor.  This interactive move is 

accomplished by deflecting the electron beam (i.e. x, y image shift) and is only active 

when the FOV is smaller than the FOV Crossover value.    

11. SEM>SEM Viewer Toolbar>Histogram: Add histogram display which shows the gray-scale 

distribution of the SEM image.  

 

FIXED FROM PREVIOUS VERSION 

3. SmartSoft>Menu Bar>Spectrum>Smooth/Derivative Setup: Added back the option to 

normalized differentiated data to 1eV/Step.  This feature was precipitately removed from 

the previous version. 

4. SEM>SEM: Scintillator Auto: The Scintillator auto mode not initialized at startup.  The 

check box must be unchecked and checked before the selection is recognized. 

5. SEM>SEM: Stopping the “Read Beam Current“ locks up communication to the Keithley.  

This problem may also cause other SEM commands to become very slow (e.g. changing 

the magnification).  Note: Issue is more pronounced using the newer 6485 Keithley vs. the 

older 485 Keithley. 

6. SEM>SEM Viewer>Photo: The photo preview will lock up the software if the annotation 

comment is too long for the DSM monitor.  This lock up problem has been corrected, but 

the DSM still displays only a single line of comment information (as expected). 

7. AES>Analysis Area: Analysis areas defined during the acquisition setup are shifted slightly 

during the acquisition.  Updating the PC2Vision.txt file corrects this problem. 

8. AES>Data Viewer>Close All: Minimize excessive flashing when 'Close All' selected.  

Problem most visible when many files are displayed. 



9. Hardware>Ion Gun: On systems configured with the manual valve control (i.e. no 

Watcher) the ion gun "auto V4" and "auto V8" are now correction disabled.  This bug was 

interfering with normal ion gun operation. 

 

HELPFUL HINTS 

4. Entry fields must be 'terminated' either by selecting the <Enter> key or by moving to 

another parameter field.  If the application is exited before the value is terminated the 

change will not be saved. 

5. System>Vacuum: A “Diff pump Ion gun On“ task failure is typically caused by an 

incompatible version of the Watcher macros.  This can be fixed by updating the Watcher 

macros.  Workaround: Use the “Diff pump Ion gun On“ task from inside the Watcher 

program.  

6. System>Stage>2 Inch Sample (60mm): Using "Defect File" style navigation limits stage 

motion based on the tilt angle (indicated by the red line on the sample viewer).  "Intro 

Photo" style navigation removes the stage limits, but requires additional care when moving 

the stage to avoid driving the sample into the nose cone of the analyzer. 

            

KNOWN ISSUES AND LIMITATIONS 

4. SmartSoft-AES now supports SMART-II systems with the Manual Intro upgrade.  However, 

it does not support previous configurations of the SMART-II systems with the Front 

End/FOUP 

5. Additional hardware NOT supported: SMART-200, MicroBeam Ion Gun 

 

6. For more information on known issues please see the following document: C:\SMARTSoft-

AES\Bin\TroubleShooting.doc. 

                              SmartSoft-AES Software Release Notes 

 

___________________________________________________________________________ 

 

Release 4.3.0 - July, 2011 

___________________________________________________________________________ 

 

OVERVIEW 

SmartSoft-AES V4.3.0: AES700 - Keyed stage, digital intro camera, and Windows7 support.  

SMART-Tool – Not supported in this release. 

 

 

NEW FEATURES 

General 

1. Digital Intro Camera (700xi) 

a) Digital camera support w/camera image setup and alignment 

b) Adds Point and Click sample navigation using intro photo 

c) Adds support for keyed stage (i.e. rotation offset: 150 degrees) 

2. Windows7 Support 

a) Also adds color support for either ‘Windows Classic’ or ‘Windows7’ color schemes. 

3. Add PC2-Vision frame grabber support   

a) The PC2-Vision frame grabber card is the next generation frame grabber from Coreco 

Imaging, Inc.  The PC2-Vision card is needed for Windows7, but is also compatible with 

Windows XP.  Note: The older PCVision card is only compatible with Windows XP.  

SmartSoft-AES supports either the PCVision or the PC2-Vision hardware, and is 

selectable in the Hardware Configuration menu.  On Windows7 systems, must include 

SP1 or greater. 

 



Main UI 

4. SmartSoft>Login: An “Administrator“ user level is now available with full system access.  

The default password for the administrator account is “admin“, and should be changed to a 

secure password as soon as possible.  The PHIService account is reserved for PHI service 

engineers only.   

5. SmartSoft>Splash Screen: Updated system photo w/company approved logos and letter 

head. 

6. SmartSoft>Startup: Protection added to stop two versions of SmartSoft from starting up at 

the same time. 

7. SmartSoft>File>Save Workspace:  SmartSoft-AES parameters are automatically saved to 

PREVIOUS values every 5 minutes.  This save interval can be changed by modifying the 

Auto Save Interval in the C:\SmartSoft-AES\Setting\Main\Properties\Properties.phi file. 

8. SmartSoft >Menu Bar>Spectrum>Region Display Style: A Single Plot or Multi-Plot display 

style option is now available for spectral data displays.  The single plot option will display 

all regions in a single graph (this is how SmartSoft displayed the data in previous version 

of software) while the multi-plot option will display each region in its own graph. 

9. SmartSoft>Menu Bar>Spectrum>Smooth/Derivative Setup: 

a) Data is always normalized to 1eV/Step.  The option to normalize or not to normalize 

has been removed (data should always be normalize to 1eV/Step to maintain accurate 

peak intensities needed for quantification). 

10. SmartSoft>Menu Bar>Tools>System Configuration: 

a) Intro Camera: Added intro camera option.  Note: Intro camera option is NOT available 

for SMART-Tool. 

b) Navigation Style: Sample navigation in SmartSoft-AES can be optimized to use either 

Intro Photos or Defect Files. 

i) Into Photo: The Intro Photo navigation style displays an intro photo in the Sample 

Viewer.  A 3-point alignment is used to align the intro photo to the actual stage 

positions.  A “Google” style toolbar is available for easy access to pan and zoom. 

ii) Defect Map: The Defect Map navigation style is optimized for using a KLA style 

defect file.  This navigation style includes the 3-point alignment mode, along with 

the edge and notch alignment modes.  Because these defect files often include a 

large number of defect positions there is list filtering and list sorting supported.  

The Defect Search function is also available. 

c) Frame Grabber: PCVision or PC2-Vision.  PC2-Vision card needed for Windows7 

d) Sample Parking:  The stage parking option has been moved from the Stage>Properties 

application to the Configuration application. 

e) Ion Gun Control: Added support for 20-066 hardware. 

f) Turbo Pump: Added support for Leybold 300iP Turbo Pump. Displays pump speeds as 

“>90%” or “<90%” only. 

11. SmartSoft>Menu Bar>Tools>System Colors: Graph curve colors and background colors 

can now be customized by the user. 

12. SmartSoft>Menu Bar>Login>Change Password 

a) The user can now customize the password for ‘Service’ operation. 

 

Intro Session 

13. Intro>System Birds-eye Glyph: 

a) A sample thumbnail is now displayed on the system glyph and displays the current 

sample position.  On systems with the intro camera option the thumbnail is the intro 

photo, on system w/o the into camera option the thumbnail is a mechanical drawing of 

the sample mask. 

b) The AES Gun, Ion Gun, and Scintillator Detector hardware states are displayed on the 

system glyph.  The hardware can be controlled through context menus.  i.e. <right 

mouse> <click> over the hardware of interest. 



c) Intro>Vacuum Application: Added application Log, and diagnostics menu 

 

Sample Session 

14. Sample>Sample Viewer>‘Google’ Toolbar: 

a) Adds zoom and pan control on wafer map 

b) Add stage control of X, Y, Z motion 

15. Sample>Stage>Properties>Rotation: For keyed stage use Rotation Offset=150.  This will 

align sample rotation to 0 with overlay in Wafer Viewer (intro photo or sample glyph).  

Note: transfer position will change from 0 degrees to 210 degrees. 

16. Sample>Stage: Added application log and service diagnostics menus. 

 

SEM Session 

17. SEM>SEM Viewer>‘Google’ Toolbar: 

a) Adds zoom and pan control on SEM image (X/Y stage; or X/Y image shift)  

b) Adjusting image quality: Focus, Stigmators, Contrast, Brightness 

18. SEM>SEM Viewer>Toolbar: 

a) Test Acquire: A test acquire button is now available from the SEM>Toolbar.  The test 

acquire uses parameter from the current acquisition setup menu.  If no acquisition 

setup menu is displayed, the test acquire uses the most recently displayed acquisition 

setup menu. 

b) Image Registration: A grouping of image registration buttons have been added to allow 

full setup and control of image registration.  

19. SEM>Scintillator:  Code refactored 

 

AES Session 

20. AES>Survey>Area Define: Analysis areas can now be resized using the mouse wheel. 

21. AES>Data Manager:  Data Manager simplifies and integrates: Sample Type, Intro Photo, 

Position List, and Lab Book.  User can recall data manager information from a single 

setting.     

22. AES>Data Manager>Lab Book:  Acquisition details are now included in the comment field 

(e.g. “Profile|C1, O1, Al2, Si2|Alt w/Zalar|Registration”). 

23. AES>Data Manager>Browse Directory:  The current directory has now been separated into 

an acquisition directory and a browse directory.  The acquisition directory determines the 

directory where new data file are stored and is setup using the AES>Data 

Manager>Sample tab.  The browse directory allows the user to view and display previously 

acquired data (even while data is being collected), without the worry of data being saved 

in an unexpected directory.  

24. AES>Acquisition Region Table>Toolbar: Up and down tool bar buttons are now available to 

reorder the elements in the region list 

25. AES>Acquisition Region Table>Toolbar: The add element button ‘+’ now has a ‘insert 

before’ and ‘insert after’ selection buttons to the left and right of the ‘+’.    

26. AES>Acquisition>Test Acquire: Adds ability to move between acquisition setup menus w/o 

stopping the test acquire. 

27. AES>Acquisition>More: More filenames now use a tilde (~) in the filename to indicate that 

additional data has been added to the file (e.g. 101~1.spe, 101~2.spe).  This is consistent 

with other SmartSoft software.  

28. AES>Spectral Viewer>Properties>Background Color:  The graph background color is now 

selectable.  The new default color is white, which matches the MultiPak color scheme. 

29. AES>Profile Setup>Properties>Stage Position after Zalar:  This option has been moved to 

Stage>Properties application.  This flag is now used to determine the behavior after any 

Zalar motion is complete (includes Timed Sputter w/Zalar and Rotation w/Zalar). 

30. AES>Image Registration: 



a) The user now has the ability to recover from an image registration failure during an 

acquisition.  When image registration fails a dialog box is displayed showing a ‘Retry’ 

and ‘Cancel’ option.  The user has full control of the system at this time in order to fix 

the problem.  This fix might include moving the image using the SEM>Image Shift; or 

improving the image quality using the SEM>Brightness or SEM>Contrast.  If 

registration is no longer needed the ‘Cancel’ option will continue the acquisition w/o 

registration.  To stop the acquisition after a registration failure, select the ‘Cancel’ 

option followed by an acquisition ‘Stop’. 

b) Registration areas are now colorized blue to indicate an active registration area, and 

black to indicate an inactive registration area 

c) The search area size can now be modified.  Change the search area size by selecting 

the search area box with the mouse pointer and using the mouse wheel to increase or 

decrease the size.  The search area is outer box; the registration area is the inner box. 

 

Hardware Session 

31. Hardware>Ion Gun:  Added application log and service diagnostics menus. 

 

 

KNOWN BUGS 

10. Watcher 3.0 does not support FE startup in SmartSoft-AES.  Must use Watcher 2.7. 

 

FIXED FROM PREVIOUS VERSION 

1. Sample>Z Align Display: Fixed missing annotation updates to graph during Z Align. 

2. Sample>Stage>Properties: Fixed problem where Tilt Offset value is lost after restarting 

SmartSoft.  Note: Tilt offset appeared correctly in UI, but was not set to the hardware. 

3. SEM>SEM Image:  Point and Click stage moves now correctly account for an electron 

beam rotation. 

4. AES>Survey: Fixed problem with Survey Acquisition communication failing after restarting 

SmartSoft-AES. 

5. AES>Profile: Removed 30 second delay during sputter cycle of depth profile (also fixes 

related to bug where stage rotation would fail to startup during profile w/Zalar; 30 second 

delay was a software workaround to avoid this problem) 

 

HELPFUL HINTS 

1. Entry fields must be 'terminated' either by selecting the <Enter> key or by moving to 

another parameter field.  If the application is exited before the value is terminated the 

change will not be saved.   

            

KNOWN ISSUES AND LIMITATIONS 

1. SmartSoft-AES will run on the Windows/XP or Windows 7 only. 

 

2. Supports: AES680, AES690, AES700, and AES700xi systems only. 

 

3. Requires Watcher 2.7     

 

4. Y travel is limited to ~12.0mm at 40 degree tilt; variable (i.e. 13mm at 30degrees, etc.).  

Note: error message display in UI does not clearly indicate this limit. 

 

5. SmartSoft-AES does NOT support the following hardware: SMART-Tool, SMART-200, 

MicroBeam Ion Gun 

 

6. For additional information on known issues, please see the following document: 

C:\SMARTSoft-AES\Bin\TroubleShooting.doc. 
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SOFTWARE 

VC++ 2008, Delphi 2007 

 

___________________________________________________________________________ 

 

Release 4.2.0 - January, 2010 

___________________________________________________________________________ 

 

OVERVIEW 

  SmartSoft-AES V4.2.0 Adds support for: Scintillator Detector, HERO (High Energy  

  Resolution Option), Digital Fine Focus, and Knob Box hardware.    

   

  V4.2.0 is compatible with AES-680, AES-690, AES-700, and AES-700xi systems only. 

  

NEW FEATURES IN THIS VERSION 

  1. Scintillator  

    a) A Scintillator is now standard on all new 700xi systems 

    b) Scintillator is an option in the hardware configuration application 

  2. HERO  

    a) Selectable energy resolution (0.5% to 0.05%) 

    b) Manual control of sample bias supply 

    c) Activation key required 

  3. Digital Fine Focus 

    a) Integrated fine focus control in SEM application 

    b) Digital Fine Focus is an option in the hardware configuration application 

  4. Knob Box 

    a) Knob box controls include: Magnification, Focus (Coarse and Fine),  

       Stigmation X and Y, Brightness, Contrast, Shift X and Y, AutoVideo, Image  

       Registration and Scan Speed 

    b) Knob box is an option in the hardware configuration application 

 

FIXED FROM PREVIOUS VERSION 

  1. Lab Book>Directory>File Information:  Editing the MultiPak header will corrupt  

     the data portion of the file if the current curve is changed after opening up  

     the file editor.    

  2. Sample>Stage: The 'Stop All' button fails to stop the stage during initialization.   

 

KNOWN BUGS 

1. AES>Profile: Zalar rotation may intermittently fail at the beginning of 

   a depth profile.  This bug can easily be avoided by selecting 

   Sample>Stage>Rotate w/Zalar before running the profile.  If the stage  

   rotation works during the test, it is guaranteed to work for the duration  

   of the profile.  If the test fails, simply re-start SmartSoft-AES to  

   re-establish the communication to the stage.  Re-test.      

  2. Sample>Z-Align: Annotation displayed on the Z-Align graph occasionally  

     fails to update (e.g. FWHM=0.0).  Restarting SmartSoft-AES will  

     fix this problem. 

  3. For additional information on known issues, please see the following  

     document: C:\SMARTSoft-AES\Bin\TroubleShooting.doc. 

 

HELPFUL HINTS 



  1. Entry fields must be 'terminated' either by selecting the <Enter> key or by  

     moving to another parameter field.  If the application is exited before the  

     value is terminated the change will not be saved.   

            

IMPORTANT LIMITATIONS 

  1. SmartSoft-AES is designed to run on the Windows/XP operation system only. Other 

     operating systems, such as Windows 7 and Windows/Vista, have not been tested. 

  2. SmartSoft-AES does NOT support the following hardware: Smart-200, MicroBeam  

     Ion Gun 

   

SOFTWARE 

VC++ 2008, Delphi 2007 

 

___________________________________________________________________________ 

 

Release 4.1.3 - June, 2008 

___________________________________________________________________________ 

 

OVERVIEW 

  SmartSoft-AES V4.1.3 supports one hardware, the thermo-valve control.  

  Also known troubles are fixed. 

 

CHANGE FEATURES FROM PREVIOUS VERSIONS 

  1. Configuration: Add Ar-gas Control as be selectable configuration.  

  2. SEM: Add Gain/Offset function for the caputure image. 

 

FIXED FROM PREVIOUS VERSIONS 

  1. STAGE: Shut down the motor power when exit the software. 

  2. STAGE: Enable the tilt offset after the stage initialize routine. 

  3. AES: Limit SEM/Stage/Ion gun functions during the acquisition. 

  4. SEM: Disable the persistence during Auto Video routine. 

 

SOFTWARE 

VC++ 6.0, Delphi 5 

 

KNOWN ISSUES 

  1. This SmartSoft is for Windows XP. It may not work on Windows NT computers.   

  2. For additional information on known issues, please read the following document: 

       C:\SMARTSoft\Bin\TroubleShooting.doc. 

 

SOFTWARE 

VC++ 6.0, Delphi 5 

 

___________________________________________________________________________ 

 

Release 4.1.2 - September, 2007 

___________________________________________________________________________ 

 

OVERVIEW 

  SmartSoft-AES V4.1.2 supports two hardwares, 11-065 Ion gun control and 15-630  

  w/Zalar rotation motor. Also this version does not require PC-Access. 

 

CHANGE FEATURES FROM PREVIOUS VERSIONS 



  1. Configuration: Add 11-065 Ion gun control and 15-630 w/Zalar rotation motor  

     as be selectable configuration.  

 

FIXED FROM PREVIOUS VERSIONS 

  1. SEM: Extractor voltage on SEM properties is updated after FE startup routine. 

  2. Analyzer: Can change the setting of MCD conditioning during doing it. 

 

KNOWN ISSUES 

  1. This SmartSoft is for Windows XP. It may not work on Windows NT computers.   

  2. For additional information on known issues, please read the following document: 

       C:\SMARTSoft\Bin\TroubleShooting.doc. 

 

 

___________________________________________________________________________ 

 

Release 4.1.1 - June, 2007 

___________________________________________________________________________ 

 

OVERVIEW 

  SmartSoft-AES V4.1.1 has new ability to restrict 15-680 stage motion for safety.  

  Also known troubles are fixed. 

 

NEW FEATURES IN THIS VERSION 

  1. Sample:  

    A software limit function restricts 15-680 stage motion to prevent sample from  

    crashing. "Wafer Map View" shows this safe area of movement. 

  2. DATA:  

    A new 1eV conversion mode that is equivalent to a derivative analysis of  

    MultiPak is added. 

 

CHANGE FEATURES FROM PREVIOUS VERSIONS 

  1. Main: 'Acquiring' sign is on Main view during acquisition. 

  2. DATA: Disable close button for the files in Data viewer during acquisition. 

  3. Sample: Improve the initialization algorism of 15-680 stage for safety. 

  4. AES: Indicate the 'Reference area' box in the view when setting the registration  

          image. 

  5. AES: Erased the background line on Test acquisition window during test  

          acquisition when it is 1-point mode. 

  6. AES: Reduced the size of 'Area' box. 

  7. AES: Limit the settings of Range or eV/Step. 

  8. ION: Auto save and recall settings of 'Mode after timed sputter' selection. 

  9. DATA: Automatically remove an aborted file in Lab Book. 

  10. DATA: Warn if the files saved in Lab Book are more than 150. 

 

FIXED FROM PREVIOUS VERSIONS 

  1. INTRO: Status of valves, TMP and chamber pressures are shown in SmartSoft when  

            'AES-680' is selected in Watcher configuration. 

  2. AES: Able to load acquisition settings from MultiPak file created by V4.0.0.29  

          and earliers.  

  3. SEM: SED Multiplier 'ON' in SEM properties box is working correctly. 

  4. SEM: The output image tasks are working correctly when 'DSM image' is selected.. 

  5. Sample: The caption for stage Tilt is 'T (deg)' in Relative mode. 

  6. Sample: The stage movement (rotation) using arrow key is working correctly.  



  7. Sample: Restarted Z-align acquisition is working correctly. 

  8. AES: The registration feature works correctly when doing More Map. 

  9. AES: The intensity of each spectrum is correct in window line profile acquisition. 

  10. AES: Chnage profile works correctly with changed sputter interval or changed sweeps. 

  11. DATA: Standard annotation feature does not increase the photo number. 

 

KNOWN ISSUES 

  1. This SmartSoft is for Windows XP. It may not work on Windows NT computers.   

  2. For additional information on known issues, please read the following document: 

       C:\SMARTSoft\Bin\TroubleShooting.doc. 

 

___________________________________________________________________________ 

 

Release 4.1.0 - Jan, 2007 

___________________________________________________________________________ 

 

OVERVIEW 

  SmartSoft-AES V4.1 completely replaces PCACCESS as the system control software 

  for the AES-700 instrument.  

 

NEW FEATURES IN THIS VERSION 

  1. SEM: SEM image data written to a data file is read from the raw data. 

  2. AES: Map Acquisition: 1-point method is added to Map acquisition. 

  3. AES: Map Acquisition: Frames can be changed during an additional acquisition.  

  4. AES: Profile Acquisition: Acquisition region can be changed during an  

     additional acquisition. 

  5. Sample: Stage(AES-700 systems): Service mode is added. 

  6. ION: Timed Sputter w/Zalar can be possible. 

  7. ION: The default status can be selected whether Blanking or Standby. 

  8. DSM: Acquisition Point, Area and/or Line can be displayed on DSM Monitor. 

 

 

FIXED FROM PREVIOUS VERSIONS 

  1. SEM: Auto SED is valid. 

  2. AES: Test MCD: All channels counts can be displayed. 

  3. AES: Test Offsets: Incorrective Intensity display is fixed. 

  4. AES: Window Line Profile: Incorrective Intensity display is fixed. 

  5. AES: Depth Profile w/Zalar: Zalar is working during depth profile. 

  6. AES: More Map: More Map for the ssecond times in a raw can be possible. 

  7. File: SEM image: The aspect rate of an image shown on MultiPak is correct. 

   

KNOWN ISSUES  

  1. This SmartSoft release should only be installed with Windows XP. The 

     software will not work on Windows NT computers.   

  2. For additional information on known issues, please read: 

       C:\SMARTSoft\Bin\TroubleShooting.doc.   

 

___________________________________________________________________________ 

 

Release 4.0.0 - March, 2005 

___________________________________________________________________________ 

 

OVERVIEW 



  SmartSoft-AES V4.0.0 combines the SMART-Tool only release - V3.3.0, with the  

  AES-700 only release - V3.1.2, into a single, configurable, software package. 

  This version also includes: depth profiling w/charge neutralization, and  

  die-navigation using partial wafers (optional on AES-700 systems). 

  

NEW FEATURES IN THIS VERSION 

  1. SmartSoft name has changed to SmartSoft-AES. 

  2. Status Line:  A status line is visible at the bottom of the SmartSoft-AES  

     application. The status line displays: stage position, electron beam  

     state, and ion beam state.  

  3. Sample: Wafer Map:  The die-navigation software previously available only 

     on full-wafer SMART-Tool systems, is now available on AES-700 systems. 

 

     Note: The die-navigation software is an option on the AES-700 systems, and  

           must be purchased separately. 

   

  4. AES: Profile Acquisition:  Charge neutralization using the ion gun is now  

     possible during a depth profile acquisition. 

  5. AES: Profile Acquisition:  Sputter Time and/or Sputter Interval can be 

     changed during a profile acquisition. 

  6. AES: Analysis Area Define: Analysis areas can now be displayed AND moved on  

     AES Map displays. 

  7. AES: Acquisition Elements: Elements identified from a spectral display can  

     now be imported directly into the acquisition setup menus. 

  8. AES: Test Acquire: Smooth/Differentiate is available on 'live' Test  

     Acquire data.  

  9. File: Print Setup: One can now select and change printer options within 

     SmartSoft. 

  10. Beep: Message boxes now 'beep' when displayed, to notify users that action  

      must be taken. 

  11. Help: SmartSoft-AES User's Guide:  The SmartSoft User's Guide is now 

      available from SmartSoft Help.   

 

FIXED FROM PREVIOUS VERSIONS 

  1  Intro: System Glyph: Watcher buttons and system valve states are correctly 

     disabled on systems w/o SVC/Watcher.  

  2. Intro: System Glyph: Turbo pump speed is correctly displayed. 

  3. Sample: Wafer Map: The inverted wafer map has been fixed(AES-700 systems). 

  4. SEM: SED Multiplier voltage is correctly saved in data file.  

  5. SEM: EMS voltage is set correctly when using BSE imaging mode. 

  6. SEM: The PHI symbol is now displayed correctly as SEM annotation. 

  7. AES: Map Display: Standard annotation displayed on SEM images and AES Maps 

     is now correctly read from the file. 

  8. AES: Map Display: Can now close a RGB overlay Map. 

  9. Ion: Sputter: The Ar leak valve V8 is correctly opened and closed when the 

     ion gun is turned on and off. 

  10. Ion: Sputter: E-Beam is now correctly blanked when sputtering the ion gun.  

  11. Ion: Sputter: The ion gun Beam Energy is calculated correctly when using  

      the Float option. 

  12. Dialog Boxes: Property dialog boxes now stay-on-top as expected. 

   

HELPFUL HINTS 

  1. For additional helpful hints, please read:  



       C:\SMARTSoft\Bin\TroubleShooting.doc. 

            

KNOWN ISSUES  

  1. This SmartSoft release should only be installed with Windows XP. The 

     software will not work on Windows NT computers.   

  2. AES-690 systems must use the AES-700 option when selecting the 'System' 

     and 'Watcher' options from the Configuration.exe application. 

  3. For additional information on known issues, please read: 

       C:\SMARTSoft\Bin\TroubleShooting.doc. 

 

___________________________________________________________________________ 

 

Release 3.3.0 - October 28, 2004 

___________________________________________________________________________ 

 

OVERVIEW 

  SmartSoft V3.3.0 is a SMART-Tool/SMARTT-II only release that supports  

  Windows XP. 

 

NEW FEATURES IN THIS VERSION 

  1. SmartSoft now supports Windows XP on the SMART-Tool/SMART-II instruments. 

  2. Intro: System status (e.g. valve states, system pressure, intro pressure) 

     is now display in SmartSoft on the Intro>Output Display Area. 

  3. The 'SMARTSoft' name has been officially changed to 'SmartSoft'. This 

     change was made in preparation of moving the SmartSoft technology to  

     other PHI products. 

 

HELPFUL HINTS 

  1. For additional helpful hints, please read:  

       C:\SMARTSoft\Bin\TroubleShooting.doc. 

            

KNOWN ISSUES  

  1. This SmartSoft release is intended for the SMART-Tool/SMART-II systems 

     only.  This version may function normally on other AES system, but has not 

     been fully tested.  Please use Release 3.1.2 for all other AES systems.    

  2. This SmartSoft release should only be installed with Windows XP. The 

     software will not work on Windows NT computers.   

  3. For additional information on known issues, please read: 

       C:\SMARTSoft\Bin\TroubleShooting.doc. 

 

 

 

___________________________________________________________________________ 

 

Release 3.1.2 - August 10, 2004 

___________________________________________________________________________ 

 

OVERVIEW 

  SMARTSoft V3.1 completely replaces PCACCESS as the system control software 

  for the AES-700 instrument (Official release). 

 

FIXED FROM PREVIOUS VERSIONS 

  1. Stage: Fixed problems with Compucentric Rotation(CompR).  'Absolute' and  



     'Relative' CompR moves now work as expected. 

  2. Stage: Fixed problem calibrating the center of rotation.  First time center 

     of rotation was calibrated, the center values were incorrect.  Also fixed 

     problem caused by hitting the Calibrate button multiple times. 

  3. Intro: Sample Transfer: Improved dialog prompts during sample transfers  

     (e.g. Move arm to transfer point.  Select [OK] only after arm is in  

     position).   

  4. Intro: Sample Transfer: Improved error reporting from Watcher (e.g.  

     SMARTSoft now reports the error caused when the transfer rod is not fully 

     retracted) 

  5. Fixed software lockup when using menu scrollbars.  Note: problem was only 

     seen on select computers. 

 

HELPFUL HINTS 

  1. For additional helpful hints, please read:  

       C:\SMARTSoft\Bin\TroubleShooting.doc. 

            

KNOWN ISSUES  

  1. This SMARTSoft release can ONLY be installed on a AES-700 instrument. 

     Future releases will support: SMART-Tool/SMART-II, AES-670, AES-680, and  

     AES-690 systems.   

  2. This SMARTSoft release can ONLY be installed with Windows XP.  The software 

     will no longer run on Windows NT.   

  3. For additional information on known issues, please read: 

       C:\SMARTSoft\Bin\TroubleShooting.doc. 

 

___________________________________________________________________________ 

 

Release 3.1.1 - July 14, 2004 

___________________________________________________________________________ 

 

OVERVIEW 

  SMARTSoft V3.1 completely replaces PCACCESS as the system control software 

  for the AES-700 instrument (Beta release). 

 

FIXED FROM PREVIOUS VERSIONS 

  1. SEM: Black line on right side of SEM image has been eliminated.   

  2. Ion: Sputter: Ion gun beam blanking is now working.  Also, a 'Blank' mode  

     has been added to the ion gun application. 

  3. Stage: Center-Of-Rotation offset values are now ignored when transferring  

     sample.  This fixes the problem where the transfer points seems to be  

     slightly off, after calibrating the center of rotation. 

  4. System: Turbo pump speed now displays correctly. 

  5. SEM: Fixed crash when saving an SEM image with Scan Speed set to 0.2 or  

     0.4. 

  6. The correct default values for a AES-700 system are now set. 

       - DirectDraw: No. 

       - All Scan Correction values: 0, 

       - Initial data directory set to C:\Datafiles 

 

___________________________________________________________________________ 

 

Release 3.1.0 - May 1, 2004 (Internal Release Only)  



___________________________________________________________________________ 

 

OVERVIEW 

  SMARTSoft V3.1 completely replaces PCACCESS as the system control software 

  for the AES-700 instrument (Beta release).  

 

NEW FEATURES IN THIS VERSION 

  1. SMARTSoft now supports Windows XP. 

  2. Intro: Integrated vacuum control (i.e. Watcher). 

  3. Sample: Stage: Integrated 15-680 motorized stage control.      

  4. SEM: SEM images can now be viewed and modified using Magnification (in  

     addition to FOV) 

  5. AES: Map Display: Contrast Stretch, Brightness, and Threshold operation are 

     now available for map displays. 

  6. AES: Map Display: Standard Annotation (Photo Number, Micron Marker, etc.) 

     can now be added to map displays. 

  7. AES: Test Acquire: Test acquire data can now be displayed in a 'refresh' 

     mode, in addition to the 'signal add' mode. 

 

___________________________________________________________________________ 

 

Release 2.2.0 - November 15, 2002 

___________________________________________________________________________ 

 

OVERVIEW 

  This minor release for the SMART-Tool improves automated anaysis using the  

  AutoTool capability. 

 

NEW FEATURES IN THIS VERSION 

  None 

 

FIXED FROM PREVIOUS VERSIONS 

  1. AES: Image Registration: 'Canceling' an image registration no longer locks  

     the software. 

  2. AES: Image Registration: Image registration failure during an acquisition  

     can now be 'Stopped', without restarting SMARTSoft. 

  3. MenuBar: System: AutoTool: Wafer looping correctly handles multiple 'Next  

     Position' commands inside the loop. 

  4. MenuBar: System: AutoTool: 'Data' fields are now initialize correctly when  

     a task is added.  

  5. MenuBar: System: AutoTool: 'Load FOUP' task now correctly checks if the  

     FOUP is already loaded. 

  6. MenuBar: System: AutoTool: 'Go To...' task now supports looping. 

  7. MenuBar: System: AutoTool: 'First Position' and 'Next Position' tasks now  

      correctly check if a wafer map is loaded. 

  8. MenuBar: System: AutoTool: 'Load FOUP' and 'Unload FOUP' tasks now check  

      if the stage is initialized before trying to load/unload the FOUP. 

  9. MenuBar: System: AutoTool: 'Timed Sputter' command has been added to  

      AutoTool. 

  10. MenuBar: System: AutoTool: The AutoTool sequence now defaults to the first  

      task when new sequence is loaded. 

  11. Ion: Ion Gun: Stop differential pumping task should no longer produce the  

      'Unable to stop differential pumping' error. 



  12. SEM: Manual control of the electron gun blanking has been added.  This  

      allows one to view the SEM image during stage moves (including the stage  

      moves during a defect search). 

  13. Wafer: Changed the precision for the defect size from 2 decimal places to  

      3 decimal places. 

  14. AES: LabBook: Lab books can now be printed. 

  15. AES: LabBook: Data file headers, including the file comment, can now be  

      edited. 

  16. AES: LabBook: The wafer number and defect comment are now included as part  

      of the file comment. 

  17. AES: LabBook: The wafer number and defect id can now be used to place  

      newly acquired data files into unique data directories.  This allows one  

      to select a different data directory for each wafer, during unattended  

      operations on multiple wafers.  

  18. MenuBar: Spectra: Smooth/Diff: Data can now be change back-and-forth  

      between N(E) and dN(E) displays simply by pressing and un-pressing the  

      Smooth/Diff button  

  19. AES: Data acquisitions now check if the beam current is left on before  

      acquiring data.  The beam current is shut off, and the acquisition  

      continues. 

  20. Wafer: Z-Align: A 'Refresh Z-Align' feature was added to the Z-Align.   

      This feature allows one to quickly restart the Z-Align after changing  

      parameters in the Z-Align setup menu. 

  21. AES: Acquire: The acquisition buttons now stay 'pressed' for the duration  

      of the acquisition.  This allows for better feedback of the system state.    

  22. AES: Acquire: Integer values can now be typed in to the time/step field  

      in the acquisition setup menus (i.e. not just 1, 5, 10,...). 

  23. AES: Periodic Table: Palladium label was corrected. 

 

___________________________________________________________________________ 

 

Release 2.1.0 - January 31, 2002 

___________________________________________________________________________ 

 

OVERVIEW 

  This minor release for the SMART-Tool improves wafer transfer reliability  

  and wafer recovery. 

  

NEW FEATURES IN THIS VERSION 

  1. Wafer Retry.  During a wafer transfer the wafer moves to many stations  

     (Pre-aligner, Elevator,...).  At many of these stations a sensor is checked 

     to insure that the transfer is proceeding correctly.  Many of the transfer  

     errors occur not because the transfer has gone bad, but simply because the  

     sensor has failed.  Transfer failures have a good possibility of working if 

     they are re-tried.  Because of this, many operations like picking and  

     placing wafers, or moving the elevator, or pre-aligning wafers are re-tried  

     after failure.  This is what is meant by the new 'wafer retry' software  

     feature.  Note: This retry should be transparent to the operator. 

  2. Wafer Recovery.  Once a wafer transfer failure has occurred the operator  

     typically has only one course of actions, which is to call the service  

     engineer.  The new wafer recover feature allows the operator to safely  

     remove a wafer from the system without a service call.  A wafer 'Recovery'  

     button will become available after a transfer error. By selecting this  



     'Recovery' button, the operator will be guided through the steps needed to  

     remove the wafers from the system. 

      - Note: the wafer recovery software will only recover wafers from one of  

        the following stations: Robot, Pre-aligner, Elevator, or Stage.  Also,  

        care should be taken to verify a wafer position before attempting to  

        recover the wafer. 

 

FIXED FROM PREVIOUS VERSIONS 

  1. The FIB Gun source usage timer is now correct. 

 

___________________________________________________________________________ 

 

Release 2.0.0 - January 31, 2002 

___________________________________________________________________________ 

 

OVERVIEW 

  SMARTSoft V2.0.0 completely replaces PCACCESS as the system control software 

  for the SMART-Tool. The previous version of the SMART-Tool software used  

  SMARTSoft V1.4.0 for sample handling, and PCACCESS V7.2 for data acquisition. 

  All SMART-Tool system control is integrated into SMARTSoft.  

  

NEW FEATURES IN THIS VERSION 

  1. Restore Defect Map and Alignment Points with a single button press. 

  2. General user interface and usability improvements: 

      - Integrated wafer handling, stage movement, SEM imaging and AES data  

        acquisition. 

      - Standard graphical user interface appearance and operation. 

      - Extended use of mouse (Point&Click) for interactive input and parameter  

        adjustment. 

      - Number of user setting entries has been extended. 

  3. Enhanced viewing options: 

      - Fullscreen view of Defect Map, SEM Image, FIB Image and AES Data. 

      - One screen view containing Defect Map, SEM Image and AES Data. 

      - All AES Data can be viewed simultaneously during an acquisition  

        (e.g., all spectral regions, both spectral regions and profile/line  

        intensities, or all map regions). 

  4. Improved electron gun interaction: 

      - Step-by-step guide for tuning the electron gun. 

      - Tune parameters by moving the mouse over the live SEM Image  

        (Point&Click). 

      - Electron gun is blanked during position to position stage moves. 

  5. Standard directory tree selection and file maintenance. 

  6. Integrated 'Lab Book': 

      - All files created as part of the analysis are recorded as entries. 

      - Entries reference the defect number, actual x and y stage position and  

        position list. 

      - Additional operator comments can be entered. 

      - Data can be displayed by selecting entries. 

      - Extended customer and operator information can be entered. 

  7. Improved analysis area (area/point/line) interaction: 

      - Interactive placement and sizing using the mouse on SEM Image  

        (Point,Click&Drag). 

      - Parameters can be saved and loaded as settings. 



      - Parameters can be loaded from a data file. 

  8. AES acqusition set up: 

      - Analysis regions can be shared between acquisition setup menus  

        (e.g., Profile setup can be shared with the Map setup). 

      - Analysis regions can be selected active/inactive.     

  9. Test acquire to set up analysis regions (for Multiplexes, Profiles, Lines  

     and Maps): 

      - Browse mode where the analysis point can be interactively moved on the  

        SEM Image with the mouse (Point&Click) and the AES data will  

        automatically refresh. 

      - Previously acquired data (e.g., Survey Data) can be used to set up  

        analysis regions, such as two/three point energies. 

 10. Data reductions are now valid on data as it is acquired (Smooth,  

      Differentiation, Peak Id, Zoom, Energy Cursors). 

 

HELPFUL HINTS 

  1. Resizing or moving the SMARTSoft window may become impossible if the window  

     is accidentally moved  partially off screen.  One can, however, restore the  

     original window location by selecting 'Minimize' from the context menu  

     displayed by right mouse click on the SMARTSoft button in the application  

     bar at the bottom of the Windows workspace, followed by selecting  

     'Restore'. 

  2. Point&Click control of the electron gun stigmation is best used as a coarse  

     adjustment only.  Fine adjustment of the stigmators is best handled by the  

     up and down arrows keys in the SEM Hardware application while viewing the  

     data on the DSM. 

  3. Values typed into parameter fields should be 'terminated' either by  

     selecting the <Enter> key or by moving to another parameter field.  If the  

     application is exited before a value is terminated, the change will not be  

     saved.   

            

KNOWN ISSUES 

  1. This SMARTSoft release can ONLY be installed and run on a SMART-Tool  

     instrument. 

  2. This SMARTSoft release can ONLY be installed with Windows NT 4.0/SP5   

  3. SMARTSoft performance can be very poor when ISIS and/or MultiPak is also  

     active. This performance problem may also affect system printing. 

  4. Turning off the ion gun in the flow menu will close the differential  

     pumping valve, V4. This will cause the chamber pressure to rise slightly  

     over the next few minutes due to residual argon gas.  There is no other  

     danger and the chamber pressure should drop again as pumping continues. 

  5. If the image shift values are too high at the time of area definition, the  

     FIB milling area may be outside the milling capability.  Must move the  

     stage or center the image on the desired area. 

  6. If a center of rotation calibration is done while a 6-point edge alignment  

     is active, the edge alignment points are corrupted. The alignment has to be  

     cleared before any navigation can proceed. 

  7. Drive relative doesn't always update the absolute target position. 

  8. If a double quote (") is entered into the defect list 'Class' description  

     field and saved as a defect list, the list will not be able to be loaded. 

  9. Estimated acquisition times are not correct.  The actual acquisition times  

     are, however, correctly recorded when the acquisition is complete. 

 10. Image Registration during an acquisitions can become 'lost' when the image 



     contrast/brightness changes dramatically.  This will require the software  

     to be exited and restarted.  This problem can be more severe during long,  

     overnight acquisitions. 

 11. Image Registration during an acquisition may lock up the software if there  

     is not a valid reference image.  Note: reference images are not saved when  

     the software is exited. 

 12. The software includes a warning message when a new user setting is loaded  

     into an application before the previous user setting is saved.  This  

     warning is not, however, available in the FIB and Wafer Align applications. 

 13. Only exit the software using one of the following three methods: selecting  

     the File>Exit menu item, selecting the 'X' in the upper right corner of the 

     window, or by selecting 'close' from the context menu displayed by right  

     mouse click on the SMARTSoft button in the application bar at the bottom of 

     the Windows workspace. Exiting the software in a mode other than this will  

     require a reboot of both the system and DAS computers. 

 14. A single 'beep' can be heard when entering a value into a combo box, or a  

     comment field.  This beep is normal. 

 15. Two attempts are needed to display an application on top of the SMARTSoft  

     window. 

 16. Acquisition elemental regions are limited to 1000 data points.  This limit  

     does not apply to surveys.  Exceeding this limit will result in incorrect  

     data. 

 17. The 'Close All' function in the Lab Book will remove all files from the  

     SMARTSoft display.  This also includes any file currently being acquired.  

     If one accidentally closes the file being acquired, allow the acquisition  

     to complete, and then re-open the file. 

 18. Changes made to the acquisition setup parameters DO NOT take affect until  

     the acquisition is stopped and restarted. 

 19. Changes made to the hardware during an acquisition DO, however, immediately 

     take  affect.  Changing hardware during an acquisition is not recommended. 

 20. The Y-axis of graphical displays can become inverted during certain zoom  

     operations. The scale can be easily restored by dragging the Y-axis with  

     the mouse and releasing it with the mouse positioned below the X-axis.   

     The X-axis can also become inverted.  

      - Note: If the X-axis is inverted during a Test Acquire the software  

        will crash. 

 21. Analysis areas and points can be easily displayed on AES Maps.  These  

     graphical objects, however, can not be moved by the mouse on the map  

     display.  The objects can only be moved through the Analysis Areas  

     application. 

 22. The FOV and Micron Marker track any FOV change in the SEM application even  

     with the SEM 'Imaging' off.  This will cause the FOV and Micron Marker to  

     be incorrect for a frozen image.  Turning the SEM Imaging back on will  

     correct the scale. 

 23. Don't use SEM Photo Frame Rates of 0.4 or 0.2.  This will lockup the  

     software.  The factory setting of 1.7 is recommended, and works without  

     lockup. 

 24. The scan speed (Fast, Medium, Slow) selected when defining the analysis  

     points should exactly match the scan speed selected during the data  

     acquisition.  This will ensure that the analysis areas are correct.  

 25. Changes made to the 'Comment' field in the Lab Book Details dialog box are  

     not remembered when the dialog is closed.  Only make changes to the  

     comment in the Lab Book application input tab.    



 26. Changing the reference magnification causes Point&Click image shift to  

     fail.  Restart the software after changing the reference magnification. 

 27. The wafer map does not 'blink' the current defect position when in the  

     'Zoom' cursor mode. Changing out of the 'Zoom' cursor mode will reactivate  

     the blinking. 

 28. The pre-sputter portion of a 'Continuous' Profile is not displayed  

     correctly in MultiPak.  The distorted portion can be removed from the  

     display using the expand capabilities in MultiPak. 

 29. For a Test Acquisition the analysis area may appear as an area even though  

     a point is selected.  To correct this select an area and resize the area to  

     be a point.   

 30. There can be a significant delay from the time the acquisition button is  

     pressed to the actual beginning of the acquisition.  This delay increases  

     as the number of points/areas/cycles to be acquired increases.  Profiles  

     are typically the worst, where the delay can be several minutes.  

 31. AutoTool processing will stop if a Load FOUP command is run when the FOUP  

     is already loaded.  This will lock the UI and SMARTSoft must be restarted. 

 32. AutoTool processing will stop if a Next Wafer command is run without a  

     valid position list.  The sequence can be restarted after loading a valid  

     position list. 

 33. The AutoTool 'Setting' field is not initialized correctly, even though the  

     'Task' may appear to have been added with the correct default 'Setting'.   

     The pulldown must be re-selected for the value to be set. 

 34. The date is not updated correctly on the SEM display and always displays  

     the date the software was started. 

 35. The electron gun beam current reading must be turned off before starting an  

     acquisition. The acquisition software will lock up if the beam current  

     reading is left on, and the software must be restarted. 

 36. The FIB "Reinitialize" progress box remains on the screen even after the  

     reinitialization is complete.  Once the progress box has stopped updating, 

     wait 10 seconds, and close the progress box. 

 37. Unable to mill with the 'Polish' setting when using more that 20 steps. 

 38. Image registration fails on a multi-area profile acquisition when  

     registering every area. 

 39. A 'More' acquisition will crash the software if all regions are turned off. 

 40. Restoring a wafer list with no wafers in the system causes the software to  

     lockup.  

 41. The FIB Gun source usage timer is not correct as it is reset when the  

     software is restarted. 

 

 

 



___________________________________________________________________________ 

 

REPORTING SOFTWARE RELATED ISSUES 

___________________________________________________________________________ 

 

Please report all software performance issues to the PHI Customer Service Department. 

  

 Mailing Address: 

 Physical Electronics-USA 

 PHI Customer Service 

 18725 Lake Drive East 

 Chanhassen, MN   55317 

 

 EMAIL:        service@phi.com 

 

 


